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  Introduction

 Raw Image Files

Many digital cameras, particularly high end consumer and professional models, allow 
the user to store images in raw, rather than the more commonly used JPEG format. 
Raw images contain far more information than images saved in the JPEG format, 
storing all the information captured by the image sensor of the camera.  

When the camera saves images in the JPEG (or TIFF) format, it processes the data 
from  the  sensor,  applying  white  balance,  sharpening,  and  colour  manipulations 
among others.  Some of these manipulations are at the users control, for example 
setting different white balance modes, while others are not.  

The  JPEG image format  is  very  useful  for  many purposes,  as  it  provides  highly 
compressed  images  (using  less  digital  storage  space),  however  it  has  some 
limitations.  Firstly, the JPEG image format (usually) only provides a palette of 16.7 
million colours.  While this is adequate for many purposes, it is limiting in terms of 
post  processing.   Raw  formats  can  typically  store  16.7  billion  colours  (12  bit 
cameras)  or  4.3 trillion colours (14 bit  cameras).   Capturing more tonal variation 
allows greater flexibility during post processing of 
digital  images,  such  as  adjusting  exposure, 
lightening shadows, or raining in highlights.  The 
second  limitation  of  the  JPEG  format  is  that  it 
(usually) employs 'lossy' compression.  This means 
that, using advanced image processing algorithms, 
areas of the image which look almost the same, are 
averaged,  and  encoded  only  once,  rather  than 
multiple times.  While this saves a lot of storage 
space,  it  results  in  compression  artefacts  (see 
Figure 1).

Rawstudio User Guide (version 1.2) Page 2

Figure 1: An extreme example of  
'lossy' JPEG compression.



 Rawstudio

The main difficulty when working with raw image files, is that they must be post-
processed by the photographer,  before being ready to share,  print,  or edit  further. 
This  post  processing  allows  the  photographer  to  tweak  the  exposure,  change  the 
highlights and shadows, set the white balance, and often much more.  

Raw  image  processing  typically  involves  loading  the  raw  files  into  a  software 
package, where edits are made, and the processed image is exported as a JPEG or 
TIFF.   Often,  this  is  done  using  proprietary  software  provided  by  the  camera 
manufacturer.

Rawstudio  is  an  open  source  software  package  which  is  designed  to  allow 
photographers to quickly sort and process their raw image files, in an intuitive and 
streamlined manner.
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  Features

Rawstudio has a number of excellent features:

• Intuitive interface

• Fast and responsive

• Quick sorting of images

• Batch processing

• Realtime histogram

• Exposure mask

• Cropping

• Straighten

• Post-exposure controls

◦ Exposure

◦ Saturation and hue

◦ Contrast and curves

◦ White balance

◦ Sharpen

◦ Rotation

• Full screen mode

• Colour management

• Internal processing is 16 bit
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  Getting Started

 Layout

Figure 2 shows the main Rawstudio window.  At the top of the window are the menus 
File, Edit, Photo, View, Batch and Help.  Directly below these menus is the iconbox; 
this shows some of the images in the collection currently being worked on.  The 
scroll bar below the iconbox allows the user to scroll through the icons to select any 
image to work with.  At the left hand side of the iconbox are several tabs, clicking on 
these limits the pictures which are displayed in the iconbox.  For example, clicking on 
the tab labelled '1 (0)' will show all the images currently marked as priority one.  The 
number in brackets shows how many images are currently in any category.  The tabs 
are:
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Figure 2: The main window of Rawstudio with some images loaded.



* All images

1 Priority one images

2 Priority two images

3 Priority three images

U Unclassified

D Images marked for deletion

To the right of the main image, is the toolbox.  The toolbox contains numerous tools 
which will be covered in more detail later.  Each tool has a small triangular symbol 
beside it (either  or ).  Clicking on the symbol  will show a hidden tool, while 
clicking on the symbol  will hide a currently visible tool.

At  the very bottom of  the  toolbox,  details  of  the photograph are  shown,  such as 
shutter speed and aperture size.  

At the bottom of the main window is the status area – this shows the current status, in 
Figure 2 simply reading 'Ready'.
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Basic Usage and Workflow

Rawstudio is designed to provide a streamlined workflow to allow rapid processing 
of images.  The basic workflow is to open a collection of images, sort them into 
different priorities and discard unwanted ones, perform adjustments and corrections, 
then export the images for further editing, or printing, archiving etc.  

It is important to understand that Rawstudio does not make any changes to the raw 
files, all adjustments are stored separately, meaning that there is no loss of quality 
until the images are exported.  It should also be understood that exiting Rawstudio 
does not loose any data, it will open in the same state it was closed.  In addition, 
priorities  and  edits  made  to  images  are  stored  long  term,  such  that  opening  a 
collection of images that were processed in Rawstudio in the past, will restore the 
edits, adjustments and priorities which were set then.

Opening Collections of Images

There are two ways to load images into Rawstudio, firstly by 
opening the  File menu and selecting  Open Directory – this 
allows browsing and selection of a directory.  Alternatively, 
Rawstudio contains a built in directory browser (see Figure 
3), which allows selection of directories, and also recursive 
opening.  

Recursive  opening  means  that  any  directories  within  the 
selected directory are also opened.  For example, a directory 
called  'Beach Shoot 07-09' containing subdirectories  called 
'Samantha' and  'James',  can  be  selected  using  the  built  in 
directory  browser,  and  all  the  images,  including  those  in 
'James' and  'Samantha' will be opened.  Note that recursive 
opening is not  possible with the  Open Directory command 
from the File menu.  

To access the built in directory browser, click the tab labelled Open at the top of the 
toolbox (see Figure 3).  Use the scroll bar on the right to scroll up and down, and the 

 and  symbols to open or close directories.  To select a directory for Rawstudio to 
load, double click on any directory.  To enable or disable recursive opening, tick or 
untick the tick-box at the top of the browser, labelled Open recursive.  
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Figure 3: Rawstudio 
built in directory 
browser.



Navigating Image Collections

Once  images  are  loaded  into  Rawstudio,  they  are 
displayed  in  the  iconbox (see  Figure  2 on  page  5). 
Clicking  on  any  image  will  display  it  in  the  main 
image  display  area.   Using  the  scrollbar  below  the 
iconbox it is possible to view all of the currently loaded 
images.  Hovering the mouse pointer over an image in 
the  iconbox displays  information  about  that  image 
(Figure 4).  

Zooming

Right clicking (and holding the right mouse button down) on an image in the main 
image view opens a context menu which allows selection of zoom level, either Zoom 
to fit or Zoom to 100%.  Zoom to fit zooms the image to fit in the current window, 
such that the whole image is visible, whereas Zoom to 100% zooms in to the image to 
show a small section of it pixel for pixel – that is, one pixel in the image occupies one 
pixel on the monitor, such that detailed inspection of small image areas can be made.
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Figure 4: Image information.



  Prioritising and Sorting

A key part of rapid photographic workflow is sorting images; some to be deleted, 
some to be processed immediately and some later.  Rawstudio allows images to be 
quickly and easily prioritised.  

When a photograph is displayed in the main display area, pressing either 1, 2 or 3 on 
the keyboard will give the photograph the corresponding priority.  Pressing the delete 
key will mark the photograph as deleted (note that this will not delete the raw file), 
wile pressing 0 (zero) will remove any priority (including delete).  It is also possible 
to set the priority of the current image by going to the  Photo menu, and then  Set  
Priority.  

Several images can be given the same priority by selecting more than one in the 
iconbox,  this can be achieved by cliking multiple images while holding down the 
Control (Ctrl or CTRL) key.  Alternatively, a range of images can be selected by 
selecting the image at one end of the range, then holding down the  Shift key, and 
clicking the image at the other end of the range.  After selecting multiple images, the 
priority can be set as usual.

The  priority  tabs  on  the  left  side  of  the 
iconbox (Figure  5) are used to filter which 
images  are  currently  displayed  in  the 
iconbox.  In Figure 5, the * tab is selected, so 
all images (except those marked  delete) are 
displayed.   The  number  in  brackets  shows 
that there are 16 such images.  Selecting the 
1 tab would show all priority one images (in 
this case, two of them).  Tabs 2 and 3 function in the same way.  The U tab shows all 
currently un-prioritised images, and the D tab shows those marked delete.  

Photographs  marked for  deletion can be deleted  permanently  by selecting  Delete 
flagged  photos from the  file menu,  or  by  pressing  Control,  Shift,  and  D on  the 
keyboard.  
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Figure 5: Priority tabs



  Image Adjustments and Corrections

Many  adjustments  can  be  made  to  images  in 
Rawstudio,  most  of  these  are  performed  from  the 
toolbox (see Figure 2 on page 5).

Many adjustments are made via sliders, such as those 
shown in Figure  7.  Clicking and dragging the slider 
adjusts  the  value,  while  clicking  on  the  small  blue 
circular arrows resets the slider to its original position.

It is possible to revert an edited image to its original 
state by selecting Reset Settings from the Edit menu.  

The  last  adjustment  may  also  be  undone,  using  the 
Revert Settings option from the Edit menu (or using the 
keyboard shortcut Control+Z).  

In Rawstudio it is possible to have three different sets of adjustments for one image, 
these are represented by the  A,  B, and  C tabs at the top of the  toolbox.  Each tab 
contains the same tools, but they can be applied independently.  Clicking on the a, b 
or c tab will reveal the settings in that tab, and instantly apply those to the image in 
the main view.  It is possible to directly compare different versions by ticking the 
Split box from the  View menu.  In split mode, selecting either the  A or  C tab will 
display that image alongside the B version.

 The Histogram

The  histogram which  is  displayed  in  the 
bottom of the  toolbox (Figure  7), is updated 
in  real-time  as  adjustments  are  made. 
Coloured circles  are  used in  the top left  to 
represent  red green or  blue  channels  which 
are  currently  underexposed  (are  outside  the 
range  of  the  image).   The  same  coloured 
circles  are  used  on  the  right  to  show 
overexposed channels.  The circles fade in as 
the  channels  are  just  beginning  to  become 
over  or  underexposed.   In  Figure  7,  the  red,  green  and  blue  channels  are  all 
underexposed,  and  the  red  channel  is  overexposed.   The  blue  channel  is  just 
beginning to be overexposed.  

 Exposure

The  exposure slider  allows  you  to  adjust  the  exposure  of  the  image,  essentially 
controlling the lightness of the image by moving the slider left and right.
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Figure 7: Histogram as shown in toolbox

Figure 6: Part of the toolbox



 Saturation

The saturation slider adjusts the colour saturation, sliding this all the way to the left 
removes all colour from the image, producing a grayscale image.  It should be noted 
that colour adjustments, such as those made with the tint slider are applied before the 
saturation.  This means that even when the image is completely desaturated, the tint  
slider will have an effect on the grayscale image produced.  This can be used to select 
what colours are dominant in the creation of the grayscale imge – similar to using 
coloured filters when shooting with black and white film.

 Hue

The hue slider alters the hue of the colours in the image.  

 Contrast

The contrast slider adjusts the contrast of the image.

 Warmth / Tint (White Balance)

The warmth slider adjusts the warmth of the image, making it cooler when dragged to 
the left, or warmer when dragged to the right.  In addition, clicking anywhere on an 
image without specifying another tool, will set that point as the white reference for 
the white balance.  If there is a white object in the image, this is a quick way to 
accurately set the white balance even under unusual lighting.  To reset to the camera 
white balance press 'c' on the keyboard, to perform auto white balance, press 'a' on 
the keyboard.  Both the camera and auto white balance options are also available 
through the Photo menu by selecting White Balance.  

The tint slider adjusts the tint of the image, between this and the warmth slider, the 
white balance is controlled.

 Contrast

The sharpen slider adds a unsharp mask to the image.  As the slider is moved to the 
right, the intensity of the unsharp mask increases.

 Transforms

The row of buttons under the Transforms heading is used to flip and rotate the image. 
From left to right the buttons perform:

• Vertical flip (over the x-axis)

• Horizontal flip (over the y-axis)

• Rotate 90o counter clockwise

• Rotate 180o

• Rotate 90o clockwise
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 Sharpen 

The Sharpen slider applies an unsharp mask to the image, to increase the apparent 
sharpness as it is dragged to the right.  Dragging all the way to the left, reducing the 
sharpening to 0.00, will disable the unsharp mask.

 Straighten

The straighten tool an be accessed by clicking 
and holding the right mouse button on an image 
in the main image area, or through the  Photo 
menu.  Once selected, use the left mouse button 
to click and hold it down to drag a line on the 
image.  The image will be rotated such that the 
line just dragged is made horizontal.  Figure  8 
illustrates  how  a  line  may  be  drawn  on  this 
image in order to make it straight.  

 Cropping

The  crop tool  can  be  accessed  through  the 
Photo menu,  the  right  click  context  menu,  or  by  pressing  Shift  and  C  on  the 
keyboard.  Once activated settings for the crop tool can be adjusted from the bottom 
of the toolbox.  Several grids can be used to help frame the cropping, and aspect ratio 
of the crop can be constrained to allow framing for a particular print – both of these 
are set from the toolbox via drop-down menu boxes.  A cropping rectangle is drawn 
on the image by clicking and holding the left mouse button, and dragging to form a 
frame.  Once the left mouse button is released, the frame can be adjusted by clicking 
and dragging the corners when the mouse pointer changes to the  icon, or moved 
by clicking and dragging when the mouse pointer changes to the  icon.
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Figure 8: Drawing a line to use as the 
horizontal



  Exporting

 Single Image Exporting

Single images can easily be exported quickly.  Quick export, available from the file 
menu or by pressing Control and 's' on the keyboard will export the current image, 
using the currently displayed modifications, in the currently set export format, to a 
directory (folder) called exports, inside the directory (folder) in which the raw files 
are contained.  

Similarly, Export As, available from the file menu, or by pressing Control, Shift and 
's' on the keyboard, will produce a dialogue box so that the exported file can be saved 
in a specific location.  As with quick export, the current adjustments are used, by the 
Export  As dialogue box allows a specific output file format to be selected, and a 
quality or compression to be set.

Finally, Export to Gimp, available from the file menu, or by pressing Control and 'g' 
on the keyboard, will use the current adjustments to generate an image, and open it in 
the GIMP image editor.

 Batch Exporting

Combined with sorting images  into priorities,  batch exporting is  a  very powerful 
feature of Rawstudio.  Before a batch export can be completed, images which are to 
be exported must be added to the queue.  Images can be added to the queue via the 
options  in  the  Batch menu.   The  Add photo  to  batch  queue option  will  add  the 
currently active photo to the batch queue, this can also be achieved with the keyboard 
shortcut control+b.  The current image can be removed from the batch queue with the 
Remove from batch queue option (keyboard shortcut control+alt+b).  The option Add 
current view to queue adds all of the images in the current view to the batch queue – 
for example, if the current view is priority 1 images, and this option is selected, all 
priority 1 images will be added to the queue.  If a single image is added to the queue, 
the currently displayed adjustments are used, whereas if several images are added, a 
dialogue box asks whether to use the A, B or C adjustments.  It is possible to export 
images multiple times using the A, B and C settings, or any combination thereof.

The batch export options are available by clicking the Batch tab above the toolbox. 
The  options  displayed  allow the  output  directory  to  be  specified,  as  well  as  the 
filename format, and the file type.  The filename format accepts several wildcards, a 
legend for which is displayed when the + to the right of the filename text box is 
clicked.  

The Batch settings also allow the images to be scaled – clicking on the Change button 
in the Scale area will show a dialogue box allowing a scaling factor to be applied to 
the images during batch queue processing.  
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Finally, clicking the  Start button will start the batch processing.  Start can also be 
selected from the Batch menu.

  Rawstudio Preferences

Rawstudio preferences can be accessed through the  Edit menu and the  Preferences 
option.  The preferences dialogue has three tabs at the top, corresponding to three 
pages of options.  

 General

This page contains general options, related to the look and feel of Rawstudio.  The 
Preview background color option allows the colour of the background of the main 
image window to be  set.   The  Histogram height option  allows the height  of  the 
histogram in  the  Toolbox to  be  set  in  pixels.   Checking  the  box  labelled  Show 
filenames in iconview causes the file names of the images to be shown below the 
icons  in  the  iconbox.   Checking the  box labelled  Place  cache  in  home directory 
causes the Rawstudio cache to be placed in the home directory, this may be useful if 
restrictions on system space exist.  The checkbox Load 8 bit photos (jpeg, png, etc) 
causes Rawstudio to open 8 bit images, as well as raw images – this is useful if it is 
desired to use the functionality of Rawstudio to process non-raw images.

 Quick Export

This page allows default settings for the Quick export feature to be set.  The output 
directory, as well as filename structure and file format can be specified.  The  Save 
uncompressed TIFF option allows uncompressed, full bit depth TIFF images to be 
saved rather than reduced bit depth images (such as jpeg).  

 Colors

This page allows colour management to be enabled or disabled, and colour profiles to 
be loaded for the input, display and export of images.  This is extremely useful for 
precision colour work.
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